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CHAPTER 1  | INTRODUCTION 

The Video Tracking Interface can be used to record locomotor activity in either Open Field 

arenas or home cage environments.   

Open-Field Activity (OFA) monitoring is a sensitive method of measuring both gross and fine 

locomotor activity in small animals.  In general, computerized OFA characterizes multiple end 

points of motor behavior, and as such, has proven to be a powerful assessment tool with many 

applications in behavioral pharmacology, toxicology, and genetics.  For example, dopamine 

agonist studies can use distance traveled in centimeters as a measure of gross motor activity 

that is amenable to quantitative analysis.  Opiate tolerance studies can examine overall distance 

traveled. 

The Video Tracking Interface (VTI) system is an alternative to infrared (I/R) beam tracking 

systems traditionally used for monitoring Open-Field Activity (OFA) in rats and mice.  With the 

Video Tracking Interface system, video cameras mounted in the cubicles perform video tracking 

of standard X and Y locomotion of subjects and, in conjunction with the Activity Monitor (SOF-

811) software included with the system, defines an X and Y coordinate “map” of subject location 

and activity.  

The cubicles used for VTI have slide-out floors that can accommodate a variety of housing cage 

platforms to permit monitoring of test subjects for longer periods of time – hours to days – in 

standard home cages, giving test subjects access to proper litter-bedding, food and water.  

Furthermore, VTI can collect tracking data from up to 2 cameras (one per cubicle) and each 

camera is capable of tracking up to 2 rat or 4 mouse test subjects (one subject per cage), 

providing the investigator with the potential to collect OFA data for up to 4 rats or 8 mice, per 

testing period.   

 

General  Computer Environment  

The minimum recommended system is as follows:  

 A 2.3 GHz or faster Dual Core computer with at least one free PCI slot for a 
single camera.  Each additional camera requires additional processing 
power.   

 Windows 2000, XP or Vista 

 1GB of RAM 

 1024 x 768 or larger screen resolution 

 500 Megabytes of free disk space (more space if videos are saved)  

 CD-Rom drive and/or DVD recordable drive for archiving video files 

 Mouse 

 Network - In order to collect the data from a remote system, the remote 
system must be connected to the tracking computer via a Windows network.  
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There are several chamber platforms available:  

 NIR-VID–515, One Rat Open Field  
Dimensions: 17.0”W x 17.0”D x 12.0”H (43.2 x 43.2 x 30.5 cm) 

 

 NIR-VID-510, Two Mouse Open Fields  
Dimensions: 11.0”W x 11.0”D x 8.0”H (28.0 x 28.0 x 20.3 cm) 

 
 NIR-VID-415, Two Rat Home Cages 

Dimensions: 18.0”W x 10.0”D x 8.5”H (45.7 x 25.4 x 21.6 cm) 
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 NIR-VID-410, Four Mouse Home Cages 
Dimensions: 10.0”W x 8.0”D x 6.0”H (25.4 x 20.3 x 15.2 cm) 

 

 

 

Mazes  

Elevated mazes are often used to detect anxiety, and the Video Tracking Interface can now be 

used to track animals on plus mazes and zero mazes.  The Video Tracking Interface (VTI) 

supports mouse and rat plus and zero mazes. 

The maze part numbers are as follows: 

 VPMM-LM, NIR Mouse Plus Maze 
Dimensions: 56”H x 41” W x 30”D (142.2 x 104.1 x 76.2 cm);   

Required Floor Space:  4’ x 7’ (1.3 m x 2.3 m) 

 VPMR-LR, NIR Rat Plus Maze 
Dimensions: 69”H x 56” W x 45” D (175.3 x 142.2 x 114.3 cm);   

Required Floor Space:  5’ x 9’ (1.6m x 3m) 

 VZM-MS, Mouse Zero Maze 
Dimensions: 18” diameter x 87” H (45.7 x 221.0 cm);   

Required Floor Space:  24” x 32” (61 x 81.3 cm) 

 VZM-RS, Rat Zero Maze 
Dimensions: 27” diameter x 87” H (68.6 x 221.0 cm);   

Required Floor Space:  3’ x 4’ (91.4 x 121.9 cm) 
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CHAPTER 2  | SOFTWARE 

Video Tracking Interface Menu Items  

When the Video Tracking Interface (VTI) software is opened, the screen shown in Figure 2-1 will 

appear: 

Figure 2-1 - VTI Screen 

 

 

Fi le Menu Options  

Figure 2-2 - File Menu 

 

 

The following options are available under the “File” menu:  

 Preferences:  Sets the camera names, turns video saving on and off, and sets the directory 

that video will be saved in. 

 Exit:  Closes the Video Tracking Interface (VTI) program 
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Video Menu Options  

Figure 2-3 - Video Menu 

 

 

The following options are available under the “Video” menu: 

 Preview:  Displays the live image from the camera currently selected.  Also displays the 

chamber tracking boundaries for each mouse/rat chamber and the current tracking location 

of the mouse/rat. 

 Calibrate:  Depending upon which type of device is being used with VTI (basic open field 

chambers, home cage platforms, or mazes) the “Calibrate” option will open one of following 

windows, shown in Figure 2-4 below.  This utility allows calibration of the tracking system 

with respect to the type of device being used.   

Figure 2-4 - Calibrate Screens 
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 Capture Video:  Starts video capture and tracking for all cameras to be operated by 

the system.  This option displays the camera images and sends tracking data to the 

data collection program, typically Activity Monitor or Video Maze.  

Options Menu Options  

Figure 2-5 - Options Menu 

 

 

The following options are available under the “Options” menu: 

 Configure Camera:  Adjusts the camera settings, including Brightness, Gain, Auto Exposure, 

etc.  (Must be in Preview mode to adjust camera settings). 

 Current Camera:  Selects the camera from which live images are displayed in “Preview” 

mode, “Calibrate” mode and “Capture Video” mode.  Choices are Camera 1 – 4, depending 

upon the number of cameras hooked up to VTI.  “Current Camera” may also be 

selected/changed by clicking the appropriate buttons on the Toolbar (described later) 

 Camera 1:  Sets the chamber type that Camera 1 is monitoring.  The options include:  

o NIR Tracking  

 One Rat Open Field (NIR-VID-515)  

 Two Mouse Open Fields (NIR-VID-510)  

 Two Rat Home Cages (NIR-VID-415) 

 Four Mouse Home Cages (NIR-VID-410) 

o Color Tracking 

 One Rat Open Field (VID-515)  

 Two Mouse Open Fields (VID-510)  

 Two Rat Home Cages (VID-415) 

 Four Mouse Home Cages (VID-410) 

o VPMM-LM (NIR Mouse Plus Maze)  

o VPMR-LR (NIR Rat Plus Maze)  

o VZM-MS (Mouse Zero Maze)  

o VZM-RS (Rat Zero Maze) 
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 Camera 2:  Sets the chamber type that Camera 2 is monitoring. 

 Camera 3:  Sets the chamber type that Camera 3 is monitoring. 

 Camera 4:  Sets the chamber type that Camera 4 is monitoring. 

 Auto Maximize:  When enabled, the main program screen will automatically maximize at 

appropriate times. 

 Color:  Changes the color of the chamber tracking boundaries, which are displayed in 

“Preview” mode and in “Calibrate”. The choices are red, green and blue and can also be 

selected by clicking the appropriate buttons on the Toolbar (described later) 

 Enable Security:  Because (X, Y) coordinate data is being sent via the network from 

Video Tracking Interface (VTI) to the data collection software, this feature allows 

only authorized users to view the VTI data, keeping networked computers secure.  

Please contact the network administrator if there are any problems using this feature.  

Please note that if VTI and the data collection software are installed on the same 

computer, this option will have no effect. 

View Menu Options  

The following options are available under the “View” menu: 

 Toolbar:  Allows Toolbar, at the top of the screen under the menu options, to be turned on 

or off. 

 Status Bar:  Allows Status Bar, at the bottom of the screen, to be turned on or off.  The 

Status Bar displays the current status of the VTI program, including the number of frames 

processed during video tracking. 

Help 

The following option is available under the “Help” menu: 

 Enter Password:  Allows entering passwords for different video tracking configurations. 

 About Video Tracking Interface…  Displays the current version of the Video Tracking 

Interface software. 
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Toolbar Options  

Figure 2-6 - Toolbar 

 

 

The Video Tracking Interface toolbar (shown above in Figure 2-6, also shown in Figure 2-1) 

contains several buttons that correspond these commonly used options:  

  - Sets camera 1 as the current camera. 

  - Sets camera 2 as the current camera. 

 - Sets camera 3 as the current camera. 

 - Sets camera 4 as the current camera. 

 - Configures the camera (brightness, gain, exposure, etc.). 

 - Sets the chamber border color to red. 

 - Sets the chamber border color to green. 

 - Sets the chamber border color to blue. 

 - Displays the current version of Video Tracking Interface. 

 

Status Bar  Options  

Figure 2-7 - Status Bar 

 

 

The Video Tracking Interface status bar (shown above in Figure 2-7, and also in Figure 2-1) 

displays status and information messages about the program.  The left side of the status bar 

displays information about each option in the program.  The right side of the status bar displays 

information about the current status of the program.  When in “Preview” or “Capture Video” 

mode, the right side will display the number of frames (images from the camera) lost per total 

number of frames sent to the data collection software and the percentage of lost frames.  It is 

important to check this information when previewing or capturing an experiment, because if the 

computer is too slow or there are too many programs running in the background, the Video 

Tracking Interface system will lose frames.  Ideally this number should be 0, however a 

percentage of frames lost less than 0.1 percent is usually acceptable. 
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CHAPTER 3  | SETTING PREFERENCES 

In Video Tracking, click File | Preferences.  This will open the Preferences dialog. 

 

Figure 3-1 - Preferences Dialog 

 

 

Each camera is assigned a default name.  The chamber type and chamber number being 

monitored by the camera determines this default name.  For example, in Figure 3-1 chamber 

type selected for Camera 1 is a Zero Maze, and it is assigned chamber 1.  Camera 2 is also setup 

as a Zero Maze, and is assigned chamber 2.  Camera 3 is setup for open field mouse chambers, 

and is assigned chamber numbers 3 and 4.  The camera name can be changed by clicking on the 

default camera name and entering the desired name.  However, it is important to note that the 

camera name is used when saving video, and therefore the camera name should describe the 

video it is capturing. 

If Save Video is checked, VTI will save video when capturing data to a Windows Media Video file 

(.wmv) located in the Video Directory.  By default, the Video Directory is set to the “My 

Documents” folder, but the directory can easily be changed by clicking on “Browse to select 

Video Directory”.   

When all settings are correct, click OK. 
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Configuring the Camera  

In Video Tracking, click Video | Preview.  This will display the video from the current camera.  

Select Options | Configure Camera to adjust the camera parameters.  Depending on the model 

of camera(s) being used with the system, some or all of the following options may be available: 

 Brightness – adjusts the black level of the camera. 

 Auto Exposure – allows the camera to control exposure time. 

 Sharpness – affects the clarity of detail in an image. 

 White Balance – calibrates a camera's color response to take into account different 

“color temperatures” of light (i.e., fluorescent light is greenish; sunlight, more blue; 

incandescent light, yellowish). This calibration allows the camera to define what the 

color white is under any of these various lighting conditions. 

 Saturation - the saturation of a color is the degree to which the color departs from 

neutral gray of the same brightness.  An attribute of perceived color, or the percentage 

of hue in a color. Saturated colors are called vivid, strong, or deep. 

 Shutter – determines how long the camera sensor is exposed during each frame 

capture.   

 Gain – a multiplier for the camera sensor signal output. 

Calibrating the Tracking System  

Depending upon whether basic activity chambers, home cage platforms, or mazes are used for 

activity monitoring, one of the following Calibration windows will be used to calibrate the 

tracking system. 

 

Figure 3-2 - Calibration Window for Open Field Chambers (VID-510 / VID-515) 

 

http://en.mimi.hu/photography/color.html
http://en.mimi.hu/photography/degree.html
http://en.mimi.hu/photography/color.html
http://en.mimi.hu/photography/neutral.html
http://en.mimi.hu/photography/brightness.html
http://en.mimi.hu/photography/color.html
http://en.mimi.hu/photography/hue.html
http://en.mimi.hu/photography/color.html
http://en.mimi.hu/photography/color.html
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Figure 3-3 - Calibration Window for NIR Open Field Chambers (NIR -VID-510 / NIR-VID-515) 

 

 

Figure 3-4 - Calibration Window for Home Cage Chambers (VID-410 / VID-415) 
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Figure 3-5 - Calibration Window for NIR Home Cage Chambers (NIR -VID-410 / NIR-VID-415) 

 

 

Figure 3-6 - Calibration Window for Mazes (VPM-MS, VPM-RS, VZM-MS, VZM-RS) 
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The panel shown in Figure 3-7 appears within each Calibration window: 

Figure 3-7 - Calibration Controls 

The function of each of the four buttons at the top the panel shown in 

Figure 3-7 is self-explanatory and will be explained further in the 

calibration instructions at the end of this chapter. 

Below these four buttons are two sets of arrow buttons, one for setting 

the orientation (“Offset”) and one for setting the size (“Size”) of the 

chamber tracking boundaries. 

The “Offset” arrow buttons (right, left, up, down) indicate which 

direction to move the chamber-tracking boundary. 

The right “Size” arrow button increases the width of the chamber-

tracking boundary and the left arrow button decreases it, while the up 

arrow button increases the height of the chamber-tracking boundary 

and the down arrow button decreases it.   

To adjust the size of the mazes, click and drag the maze lines when in 

calibrate mode. 

On the windows depicted above in Figure 3-2 and Figure 3-4, notice 

there multiple panels for calibrating the tracking parameters for up to four activity monitoring 

chambers/cages simultaneously.  Each panel is labeled (“Chamber 1…Chamber 4”) and has slider 

bars for setting tracking parameters.  For each parameter the scale of the slider bars ranges 

from a minimum value (top of scale) to a maximum value (bottom of scale).   

Calibration Instructions  

Select Options Camera 1….Camera 4 to designate the type of chamber(s) used by 

each camera in the system.  The choices include:   

o NIR Tracking  

 One Rat Open Field (NIR-VID-515)  

 Two Mouse Open Fields (NIR-VID-510)  

 Two Rat Home Cages (NIR-VID-415) 

 Four Mouse Home Cages (NIR-VID-410) 

o Color Tracking 

 One Rat Open Field (VID-515)  

 Two Mouse Open Fields (VID-510)  

 Two Rat Home Cages (VID-415) 

 Four Mouse Home Cages (VID-410) 

o VPMM-LM (NIR Mouse Plus Maze)  

o VPMR-LR (NIR Rat Plus Maze)  

o VZM-MS (Mouse Zero Maze)  

o VZM-RS (Rat Zero Maze) 
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Using Multiple Cameras  

For multiple camera systems, each camera must be calibrated individually.  Begin by selecting 

the desired camera from the Options pulldown menu, and then select the system being used 

(listed above).  The calibration procedure depends on the system being used.  Detailed 

instructions for each system follow.   

Repeat this process with each additional camera that is connected to the computer.  Once 

calibration is complete for each camera, select Capture Video from the Video pulldown menu 

and video from each camera will be displayed on the screen.  

NIR Tracking 

Calibrating NIR Open Field Activity Chambers (NIR-VID-510 / NIR-VID-515) 

1. Refer to Figure 3-3 while completing these calibration instructions.  Select the camera 

connected to the open field chamber if there is more than one system. 

2. Place the animals in the chambers. 

3. Turn on the NIR light and close the cubicle doors. 

4. Adjust the offset and size of each on-screen chamber so that the video tracking boundaries 

match the chamber boundaries.  To switch to a different chamber, click inside that portion 

of the dialog, as shown in Figure 3-8.  The active chamber will be highlighted in yellow. 

 

Figure 3-8 - NIR Open Field Calibration 

 

5. Select the desired tracking method for each chamber, Low or High Contrast.  Select Low 

Contrast when using dark colored mice on a dark colored background or light colored mice 
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on a light colored background.  Select High Contrast when using light colored mice on a 

dark colored background, or vice versa.   

6. If High Contrast Mode is selected, use the Threshold Range controls to select the grayscale 

range that the animal occupies, lower values for darker mice and higher values for lighter 

mice.  As these values are adjusted portions of the chamber screen will light up in green, 

the software will track these regions.  To optimize tracking, minimize portions of the 

chamber that are highlighted green and maximize the green highlighting of the animal. 

Calibrating NIR Home Cages (NIR-VID-410 / NIR-VID-415) 

7. Refer to Figure 3-5 while completing these calibration instructions.  Select the camera 

connected to the home cage if there is more than one system. 

8. Ensure that the chambers are oriented so that the ends with the water tubes and food 

hoppers attached are facing the cubicle walls.  Place the animals in the chambers and 

attach the lid spacers on the rear edge of Chambers 1 and 2.  These spacers will reduce 

glare from the lights. 

9. Turn on the NIR light and close the cubicle doors. 

10. Adjust the offset and size of each on-screen chamber so that the video tracking boundaries 

match the chamber boundaries.  To switch to a different chamber, click inside that portion 

of the dialog, as shown in Figure 3-9.  The active chamber will be highlighted in yellow. 

 

Figure 3-9 - NIR Home Cage Calibration 
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11. Select the desired tracking method for each chamber, Low or High Contrast.  Select Low 

Contrast when using dark colored mice on a dark colored background or light colored mice 

on a light colored background.  Select High Contrast when using light colored mice on a 

dark colored background, or vice versa.   

12. If High Contrast Mode is selected, use the Threshold Range controls to select the grayscale 

range that the animal occupies, lower values for darker mice and higher values for lighter 

mice.  As these values are adjusted portions of the chamber screen will light up in green, 

the software will track these regions.  To optimize tracking, minimize portions of the 

chamber that are highlighted green and maximize the green highlighting of the animal. 

13. If desired, use the Lighting controls on the Calibration dialog to set the day/night cycle for 

the white light.  To enable this feature check the box next to the timer settings (labeled 

“White Light”) and set the timers to the appropriate times.   To control the white light 

manually, uncheck the box and the timer will not run.  Video Tracking Interface uses the 

Windows system clock, so be sure the computer’s clock is synchronized with the time in the 

facility.  When using the timer, the White Light toggle switch on the NIR-100 should be set 

to REMOTE and the NIR Light toggle switch should be set to ON. 

 

Color Tracking 

Calibrating Open Field Activity Chambers (VID-515 / VID-510) 

1. Set the current camera to Camera 1.   

2. Remove all animals from the chambers, and insert the chambers into the Video Tracking 

cubicles.  Turn the cubicle light on and close the cubicle doors.  Note that with a Near 

Infrared system, the lighting needs to be the same for both calibration and capturing of 

video.  Turning the visible or NIR lights on and off while capturing video will corrupt the 

tracking data. 

3. Select Video | Calibrate on the VTI menu.  The screen shown in Figure 3-2 should appear.  

Click the button “Take Background Picture”. 

4. Adjust the offset and size of each chamber so that the Video Tracking boundaries match 

the chamber boundaries.  To switch to a different chamber, click on that chambers text 

(e.g. Chamber 2).  When this is done the VTI screen should look similar to Figure 3-10. 
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Figure 3-10 - Video Tracking Interface Screen 

 

 

5. Open the cubicle doors and insert the animals into the chambers . 

6. Close the cubicle doors. 

7. The VTI software should now be tracking the animals correctly with the default 

Jitter, Min Difference, and Background settings.   

8. Slight adjustments may need to be made to accurately track animals.  Figure 3-11 

shows both black and white mice being tracked with a Jitter setting of 100, a Min 

Difference setting of 40, and a Background setting of 40.  the Jitter was changed to 

allow smoother tracking of the animals position.  

9. When calibration is complete, click OK and repeat the calibration steps for each 

camera. 

 

Figure 3-11 - Adjusted Settings 
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Jitter – determines how often the center of the animal is moved.  If jitter is set very low the 

animals position will be very accurate, however the animals position will move slightly every 

frame, even though the animal is not moving.  If the jitter is set very high the animal’s position 

will only move when the animal has moved a significant distance.  It is recommended to set this 

value to 1000, which offers a good balance of obtaining an accurate center of the animal 

without excessive movement. 

Background - determines how much the current image pixels must differ from the background 

image pixels in order to be considered a valid pixel. 

Min Difference – the minimum number of pixels that must be valid in order for the image to be 

analyzed. 

 

Calibrating Home Cages (VID-415 / VID-410) 

1. Set the current camera to Camera 1.  Refer to Figure 3-12 for the VID-415 and  Figure 3-13 

for the VID-410 while completing these calibration instructions. 

2. Insert the animals into the home cages, and then insert the home cages into the video 

Tracking cubicles.  Ensure that the home cages are oriented correctly, as in Figure 3-13.  

Turn on the cubicle light and close the cubicle doors. 

3. Adjust the offset and size of each chamber so that the video tracking boundaries match the 

chamber boundaries.  To switch to a different chamber, click on that chambers text (e.g. 

Chamber 2). 

4. Select the appropriate animal color for the subject (note that only white or black animals are 

supported when using the home cages.  The activity chambers support all colors of animals.) 

5. The blue areas on the camera image indicate which pixels the VTI software interprets as 

valid.  Ideally the only blue in the image should be on the animal and the water bottle.  The 

blue areas will change depending on the animal color and brightness selected.  If the animal 

is white, any pixels that are brighter than the currently specified brightness will be 

considered valid.  If the animal is black, any pixels that are darker than the currently 

specified brightness will be considered valid.  The red square is the actual location the VTI 

software is tracking.  The red square will be placed on the last location of movement that 

contains a valid square.  Typically for white animals the default values of 30 for the percent 

visible and 110 for the brightness will work well, and for a black animal a value of 75 for the 

brightness may work.  Adjust the brightness value as necessary until the software tracks the 

animal. 

6. When calibration is complete, click OK and repeat the calibration steps for each camera. 
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Brightness – determines how dark/bright a pixel must be to be considered valid. 

Percent Visible – the image is broken into small blocks, or grids, which are then analyzed by the 

software.  Each block must have at least the percent visible number of pixels in order to be 

considered valid.  For example, if percent visible is set to 40, then each block must have at least 

40% of the blocks pixels considered valid in order for the entire block to be considered valid.  

The home cage algorithm works by taking the valid blocks, and then looking for movement in 

the valid blocks.  A valid block with movement is determined to be the animals’ location. 

Home Cage Orientation – VID-410 – When using the VID-410 chambers, changing the 

orientation of the home cages may improve the accuracy of the video tracking, especially with 

black mice.  Feel free to experiment with different orientations and calibration settings to obtain 

the best tracking accuracy. 

Figure 3-12 - VID-415 Calibration 

 

 

NOTE:  White bedding will not work with the VTI system.  For best results use wood chip 

bedding, preferably bedding with a strong red or yellow color. 
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Figure 3-13 - VID-410 Calibration 

 

 

NOTE:  White bedding will not work with the VTI system.  For best results use wood chip 

bedding, preferably bedding with a strong red or yellow color. 

 

 

Cal ibrating NIR Video Plus Maze (VPMM -LM & VPMR-LR) 

1. Set the current camera to Camera 1.  Refer to Figure 3-14 while completing these 

calibration instructions. 

2. Ensure that the Plus Maze is evenly lit, with no shadows and a consistent background.   

3. If necessary, rotate the camera lens to focus the camera.  Adjust the maze lines (the green 

lines shown in Figure 3-14) so that the lines match the outline of the maze, as shown.  The 

lines can be moved using the offset buttons shown in Figure 3-7, or by clicking and dragging 

the lines. 

4. Before placing any animals on the maze, click “Take Background Picture”. 

5. The tracking algorithm works by calculating the difference between the current image and 

this Background Picture, therefore the background must stay constant during the trial for 

the tracking algorithm to work correctly.  It is especially important that the lighting remain 

constant, therefore it is recommend that the maze not be lit by sunlight. 

6. There are three properties that can be adjusted that affect the tracking.  (Refer to Figure 

3-6) The first property is the “Background”.  “Background” refers to the difference between 

the background image and the current image.  Typically a Background value of 40 works 
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well for white or black animals.  For brown animals the “Background” value may need to be 

reduced.  The second property is the “Cluster Pixels”.  “Cluster Pixels” refers to the number 

of contiguous pixels that exceed the difference (the background setting) between the 

current image and the background image.  The third property is labeled “Head”.  “Head” is 

the minimum number of pixels that must be valid in order for a head dip to occur, and is 

also the minimum number of pixels that must be valid for an exploration to occur. 

7. As the tracking algorithm works by comparing the contrast of each pixel, it is important that 

there be a significant contrast difference between the floor and the animal.  The contrast 

between the floor and the animal is used to detect head dips.   

8. When calibration is complete, click OK and repeat the calibration steps for each camera. 

 

Background – the difference between the background image and the current image.  An image 

is composed of pixels (320 pixels wide by 240 pixels tall in this case), and each pixel from the 

current image is compared to the corresponding pixel in the Background Picture.  If the 

difference between the current pixel and the Background pixel is greater than the background 

difference, the pixel is considered valid. 

Cluster Pixels – the number of contiguous pixels that must exceed the difference (the 

background setting) between the current image and the background image in order for the 

animal to be detected. 

Head – the minimum number of pixels that must be valid in order for a head dip to occur, also 

the minimum number of pixels that must be valid for an exploration to occur. 

Figure 3-14 - Video Plus Maze (VPM-MS & VPM-RS) 
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 Cal ibrating Video Zero Maze (VZM -MS & VZM-RS)  

1. Set the current camera to Camera 1.  Refer to Figure 3-15 while completing these 

calibration instructions. 

2. Ensure that the Zero Maze is evenly lit, with no shadows and a consistent background.  

MED Associates has included built-in lights, which greatly assist in achieving proper lighting.   

3. If necessary, rotate the camera lens to focus the camera.  Rotate the camera so that the 

closed sections are in the upper-right and lower-left part of the image, as shown in Figure 

3-15.  If the camera can’t be rotated, rotate the maze outline by clicking the “Rotate Maze” 

buttons on the calibration screen.  Adjust the maze lines (the green lines shown in Figure 

3-15) so that the lines match the outline of the maze, as shown.  The lines can be moved 

using the offset buttons shown in Figure 3-7, or by clicking and dragging the lines. 

4. Before placing any animals on the maze, click “Take Background Picture”. 

5. The tracking algorithm works by calculating the difference between the current image and 

this Background Picture, therefore the background must stay constant during the trial for 

the tracking algorithm to work correctly.  It is especially important that the lighting remain 

constant, therefore it is recommend that the maze not be lit by sunlight. 

6. There are three properties that can be adjusted that affect the tracking.  (Refer to Figure 

3-7) The first property is the “Background”.  “Background” refers to the difference between 

the background image and the current image.  Typically a Background value of 40 works 

well for white or black animals.  For brown animals the “Background” value may need to be 

reduced.  The second property is the “Cluster Pixels”.  “Cluster Pixels” refers to the number 

of contiguous pixels that exceed the difference (the background setting) between the 

current image and the background image.  The third property is labeled “Head”.  “Head” is 

the minimum number of pixels that must be valid in order for a head dip to occur, and is 

also the minimum number of pixels that must be valid for an exploration to occur. 

7. As the tracking algorithm works by comparing the contrast of each pixel, certain shades of 

brown are very close to the blue background.  If the system is having difficulty in tracking 

an animal, the blue background on the maze runway can be removed to reveal a white 

background.  Also consider removing the blue plastic mats from under the maze in these 

cases. 

8. When calibration is complete, click OK and repeat the calibration steps for each camera. 

Background – the difference between the background image and the current image.  An image 

is composed of pixels (320 pixels wide by 240 pixels tall in this case), and each pixel from the 

current image is compared to the corresponding pixel in the Background Picture.  If the 

difference between the current pixel and the Background pixel is greater than the background 

difference, the pixel is considered valid. 
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Cluster Pixels – the number of contiguous pixels that must exceed the difference (the 

background setting) between the current image and the background image in order for the 

animal to be detected. 

Head – the minimum number of pixels that must be valid in order for a head dip to occur, also 

the minimum number of pixels that must be valid for an exploration to occur. 

 

Figure 3-15 - Video Zero Maze (VZM-MS & VZM-RS) 
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CHAPTER 4  | RUNNING AN EXPERIMENT 

NOTE: Calibration of the tracking system must be completed before proceeding (for directions 

see Error! Reference source not found.).  

 

1. If Mazes are being used, please refer to the Video Maze manual for information on how to 

begin an experiment. 

2. Otherwise open Activity Monitor and select File Preferences to open the following 

Preferences screen in Activity Monitor, depicted in Figure 4-1: 

 

Figure 4-1 – Activity Monitor Preferences Screen 

 

 

3. Enable the Use Video Tracker check box as shown above. 

4. The Select Computer Source option selects the computer that the Video Tracking Interface 

(VTI) program is running on.  Click on the “Select Computer Source” button to browse for 

the appropriate computer.  If Activity Monitor is running on the same computer as VTI then 

click on “My Network Places” and click OK to set the computer to as its own source, as 

shown in Figure 4-1. 
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5. Select the Number of Chambers to the number of animals that VTI is tracking.  For example: 

VID-515 / NIR-VID-515 acquires data from one animal per camera, so for a two-camera 

setup the number of chambers is two. 

VID-510 / NIR-VID-510 acquires data from two animals per camera, so for a two-camera 

setup the number of chambers is four. 

VID-415 / NIR-VID-415 acquires data from two animals per camera, so for a two-camera 

setup the number of chambers is four. 

VID-410/NIR-VID-410 acquires data from four animals per camera, so for a two-camera 

setup the number of chambers is eight. 

6. Select the Chamber Model for each chamber to the appropriate type. 

7. Click OK. 

8. Refer to the Activity Monitor manual, Setting up an Ambulatory Experiment, starting with 

the Run Open Experiment step. 

9. Configure the Activity Monitor Open Experiment form with the appropriate settings, but do 

not start the boxes (typically the boxes are started when the OK button is pressed). 

10.  Insert the animals into the Video Tracking chambers, and in the Video Tracking program 

select Video | Capture Video to start video tracking. 

11.  Now in Activity Monitor hit the OK button in the Run Experiment form to start the Activity 

Monitor chambers. 

12.  Note that after an experiment is completed in the Video Tracking program selecting Video 

| Stop Capture stops the capturing of data.  It is important that after the experiment has 

ended, video capturing be stopped, the chambers cleaned and new animals be put in before 

video capturing is restarted. 
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APPENDIX A | INSTALLING VIDEO TRACKING INTERFACE DRIVERS 

AND SOFTWARE 

The Video Tracking Interface package for the Open Field and Home Cage systems work in 

conjunction with the Activity Monitor software and the maze systems work in conjunction with 

the Video Maze software.  The Video Tracking Interface and the included supporting software 

(Activity Monitor or Video Maze) can be installed on the same computer, or two separate 

computers that are connected via a Windows network. 

The appearance of the installation screens will vary slightly for each system, but the procedure is 

the same.   

Insert the Video Tracking Interface CD, and the installation process should start automatically.  If 

it does not then open “My Computer”, open the CD drive “Video Tracking” and double-click on 

“autorun.exe”.  A screen resembling the one shown in Figure 4-2 will appear.  Click Install the … 

software and a screen resembling the one shown in Figure 4-3 will appear. 

 

Figure 4-2 - Example Main Screen 
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Click Install to begin installation of the Fire Wire Camera Driver, the Video Maze or Activity 

Monitor software and the Video Tracking Interface.  As these installations are completed, their 

status will be indicated on the screen.  A successful installation will be indicated with a green 

check mark and an unsuccessful installation will be indicated by a red X, refer to Figure 4-4.  If 

any portion of the installation is unsuccessful, please contact MED Associates Customer Support. 

 

Figure 4-3 – Example Installation Screen 

 

 

Figure 4-4 – Example of Installation Status Indicators  

 

 

Once the installation has been completed successfully, a screen resembling the one shown in 

Figure 4-5 will appear. 
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Click Finish to exit this screen.  It is now necessary to complete the secondary portion of the Fire 

Wire Camera driver installation prior to using the camera.  Refer to Appendix B for detailed 

instructions. 

 

Figure 4-5 - Installation Complete 
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APPENDIX B |FIREWIRE CAMERA DRIVER INSTALLATION 

Instal l ing the Firewire Camera Driver  

Insert the Video Tracking Interface CD, and the installation process should start automatically.  If 

it does not then open “My Computer”, open the CD drive “Video Tracking” and double-click on 

“autorun.exe”.  A screen resembling the one shown in Figure 4-6 will appear.  Click Extras and 

the screen shown in Figure 4-7 will appear. 

 

Figure 4-6 - Example Main Screen 

 

 

Click To install the Firewire camera drivers click here and the screen shown in Figure 4-8 will 

appear. 

 

Figure 4-7 - Example Extras Screen 
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Click on the operating system being used and follow the subsequent steps to complete the Fire 

Wire Camera Driver installation. 

 

Figure 4-8 – Example Firewire Camera Drivers Screen 

 

 

Instal l ing the Firewire PCI  Card  

Always turn off the power before working on the computer.  Neglecting this precaution may 

cause serious damage.  Install the Firewire card in any available PCI slot, following the directions 

provided with the computer for installing a PCI card. 

Instal l ing the Firewire Cameras  

Using the included Firewire cable, plug the first camera into any Firewire port on the Firewire 

PCI card.  Then plug the second camera into another Firewire port on the Firewire PCI card.  

Note that only two cameras can be plugged into a Firewire card.  
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APPENDIX C | TROUBLESHOOTING 

“Black Screen”  

If the Camera Window displays a completely black image, there are several possible causes.  The 

issue could be caused by a problem with the camera or connection, or the problem may be 

within the camera’s settings.  Refer to the following lists and ensure that none of these 

problems are the cause. 

Figure 4-9 - "Black Screen" 

 

Equipment Issues 

 Camera lens cap is on. 

 Camera lens not properly attached to camera body. 

 Camera lens aperture rotated to closed position. 

 Loose Firewire cable connection at camera or computer. 

 Light in Sound Attenuated Cubicle (or other closed environment) is out. 

 Computer requires reboot. 

Camera Settings  

 Brightness level not set to automatic, and level is too low. 

 Auto Exposure level not set to automatic, and level is too low. 

 Gain level not set to automatic, and level is too low. 

 Shutter level not set to automatic, and level is too low. 

Resolution 

If the equipment issues have been eliminated, set all the camera features to “Automatic”.  If 

Automatic settings are not available, set Brightness, Auto Exposure, Gain, and Shutter to the 

highest values possible.  In most cases it is recommended that the automatic camera controls be 

disabled and that the camera be controls be set manually.  This allows the user more control 

and ensures that the camera settings are uniform for multiple cameras setups.  It also ensures 

the automatic camera adjustments will not interfere with animal tracking. 
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APPENDIX D  | CONTACT INFORMATION 

Please contact MED Associates, Inc. for information regarding any of our products.   

Visit our website at www.med-associates.com for contact information. 

For technical questions, email support@med-associates.com. 

 

http://www.med-associates.com/contact.htm
Internal/support@med-associates.com
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